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ATTENTION

This text was automatically translated from German. For this reason, only the original
German text is legally valid.

Translated with www.DeepL.com/Translator

PREAMBLE

Note: This document was created with Documenter and therefore has the same content
as the

WebPage

PDF file

Windows Help and
ePub

available!

Documenter is a development by diub for the creation of documentation from one source
with different target formats.

Recommended ePub-Reader

There are masses of ePub readers. Unfortunately, most of them are simply useless;
wrong fonts, broken formatting etc. are the order of the day. Worst of all, however,is
the inability to scale, for normal users the change of the' font size'.

Below are my favorite readers with correct display.

Browser
Firefox > addon EPUBReader (https://addons.mozilla.org/de/firefox/addon/epubreader)

Android

GitdenReader (pleasantly plain and simple, always positions images and tables to
the left)

Bluefire Reader

ReadEra (basically ignores all formatting in an ePub, which is quite useful someti-
mes)

Windows
Digital Editions (Adobe), unfortunately no scaling of the images
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1 Terms of use

LIABILITY

diub makes every reasonable effort to provide correct and complete information. In this
sense, diub endeavours to correct errors after they become known. Claims of any kind
against diub cannot be derived from this.

diub reserves the right to make changes or additions to the information or programs
provided without prior or subsequent notice.

diub shall not be liable for direct or indirect damages arising from or in connection with
information or programs or the use of such information or programs.

All information or programs are to be used according to your purpose. Improper use au-
tomatically excludes all claims against diub. The same applies to consequences resulting
from defects caused by alteration of the software, damage to data carriers, misuse or
improper use. Similarly excluded are claims from damages which can be avoided by a
data backup or comparable measures.

PREROGATIVES

You are entitled to install and operate the program on exactly one computer per single
license purchased. If the program is installed on a computer with network access (e.
g. server), the user must purchase a license for each computer that has access to the
program.

Copies for the purposes of safeguarding and preserving for the future are permitted.

You are not entitled to distribute or distribute copies against payment or other conside-
ration or without consideration.

LICENCE

A license consists of a license code. Each license code is assigned a certain number of
activations. Activation takes place online. The software includes mechanisms to ensure
that the required number of activations is not exceeded (copy protection type Il).

RESTRAINTS

You may not decompile, reverse engineer, disassemble or otherwise decrypt the Soft-
ware.

You are prohibited from selling, renting, renting or sublicensing the Software.

You may not modify the Software or create derivative works from it.

UPDATES
Updates are provided free of charge as far as possible.

Updates replace the original version. Updates are not new licenses and are subject to
the same restrictions as the first version you purchased.
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2 Introduction

IDEA

Please observe these instructions:
e Change at: (9.1) Encoding of file and directory names! (Seite 15)

Synchronization means matching and adjustment, equalization. With FogMirror, syn-
chronization is unidirectional, i. e.: only in one direction; always from the source to the
destination.

As far as possible, all differences between the target and the source are eliminated. Con-
sequently, this also means that files / directories may be deleted from the target in ac-
cordance with the working mode (see below).

OPERATION

FogMirror compares the specified source directory with the target directory specified in
the pair. For this purpose, both directories including all accessible subdirectories are first
read in.

The second step compares the names, the size of files and their dates and handles the
differences according to the selected working mode.

FogMirror knows 5 different working modes.
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3 Operating modes

3.1 Mirroring

Originally, FogMirror is a mirroring tool. All changes at the source - especially deletions -
are transferred to the target.

3.2 Copying

If you only want to copy changes and new files, select Copy mode. Only files that need
to be updated are deleted or overwritten.

3.3 Generation backup / Copy with links

This creates generation directories. A new subdirectory is created in the target at each
call, the name is composed of date and time. All changes are transferred to this new
directory: new and modified files are copied, no longer existing data is copied.

The clou lies in the unchanged files: so-called hard links are created for them. A hard link
is an additional directory entry on a file that does not occupy any disk space.

REMARKS
e The previous generation directories remain unchanged until they are reused or de-
leted!

e Deletions in a generation directory have no effect on the other generations. Only
when all references - original entry or hard link - to a file are deleted, the file itself
is also deleted.

¢ Do not make any manual changes to the target except for deletions of old genera-
tions.

e Each unmodified file only exists once. Overwriting the contents of such a file applies
equally to all references - original entries as well as hard links.

3.4 Refresh last generation

The data is mirrored from the source to the last generation directory. However, this also
compares with the penultimate generation, so that hard links are set for unmodified files.

This procedure is useful if the last generation backup was terminated before the end.

REMARKS

¢ This mode is not suitable for control mode, otherwise it behaves exactly like a mir-
roring.
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3.5 Shadow copy

In the case of a shadow copy, hard links to the original files are created on the same
hard disk in a generation directory. This is sometimes referred to by other programs as
Hard-Link-Clon.

REMARKS

e Deletions in the original directory have no effect on shadow copies.
e Conversely, the same applies! Deletions in the shadow copy do not affect the origi-
nal directory.

The second point is crucial: A shadow copy is therefore very well suited for mirroring the
data in the cloud directory.

o If data is accidentally deleted in the cloud (and unfortunately this happens more
often, and not always the user is to blame), the original files will always remain
untouched.

e The whole thing also works very quickly and efficiently.

e Does not require additional disk space.
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4 Add / edit pair

FogMirror is very easy to use. In most cases, only a few details are sufficient to reach the
goal. One source and one target are required for each pair to be synchronized. There are
also a number of options for each pair, which are largely self-explanatory.

The example used is for copying a locally created Web page to the Web server via FTP.

Tt diuibs e
Quelis O \Disten'woom lochdiub de’
| i

Sl el Badail andegsn
M
@ Spisgelung (much Loschsn) Kioxpbesren Sohafterkopes (Hardink -Clons)

Generationen-Backup Letsie Gener. suffrischen

The selected working mode determines which of the options can be used sensibly.

4.1 Options

Bl achen Sellvergisch verwnden

O &

Eaphizbes Laschen |:| Loschen bai Kopeeren woroehen

0 Viedwkte Vierpsichrasss kopieeen ] Moghche Febb unterdnackes

Vedrkles [ateen bomenen

EA M kopiete Dateen prifen

e Using Simple Time Comparison
Only the time stamps of the last change are compared. FAT disks (many USB devices)
do not support extended time specifications. NTFS formatted disks allow more.

Explicit deletion

Before the actual copying process, the corresponding file is deleted correctly in the
target. This allows previously (!) installed undelete programs to save the original
version before. Important: the wastebasket alone can't do this, meaning appropria-
te extensions.

Preferring deletion when copying
All files to be deleted/replaced are first deleted explicitly, so that if there is little free
space on the target disk, later copying will be as easy as possible.

Copy linked directories / files

Linked directories are not located where they are displayed, but can be located
virtually anywhere on the data carrier. This applies, for example, to entries under
libraries. Especially there, access to the linked original directories is not always al-
lowed.

In addition, linked directories can get hints about themselves, which leads to end-
less loops. For more information, see, for example, on the Internet under the key-
word Junctions.

Check newly copied files

On drives as a destination (hard disks, USB sticks, network shares, etc.), the new-
ly written files are last read back from the destination and verified by means of a
checksum.
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4.2 Further options

£ Multi-Threadng akiivieran (schralkar bai 2 Platien)

E Zwischanspeichening aktiviarsn 1 Speichera Cacha jokal

Genarationan (1-1022);, 10
[ lgnoviens umverinderis Generation

[ Allere Generalionen wiedervrsenden

¢ Activating multi-threading
Source and destination are read in at the same time; this is only faster if source and
destination are located on different data carriers / FTP servers. For SSD disks, also
with the same hard disk.

¢ Activate buffering
Speeds up the reading of the target directory by inserting a file into the target di-
rectory that contains the complete directory tree.

e Save cache locally
The cache file is saved to the local disk in the user directory. This speeds up the
reading and writing of the file; for example, with FTP.
Important: this option is not always available or useful if the target disk cannot be
clearly distinguished.

e Generations

With each generation, another hard link is added for an unchanged file. Each hard
link needs more time to create it, the more hard links for a file already exist. There-
fore, the processing speed decreases significantly over time. This is a phenomenon
of the operating system or file system and not a feature of FogMirror.

You can set the maximum number of generations: this means that the oldest gene-
rations are deleted after this number has been exceeded. Note: Files not included
in younger generations will be deleted!

¢ Ignore unchanged generations
FogMirror first checks whether changes have taken place at all. If not, everything
stays the same.

¢ Reuse older generations
This speeds up the working process. Instead of first creating a complete new gene-
ration and then deleting the oldest generation, the oldest generation is converted
to the new generation.

4.3 In- / Exclusions

Unused files and / or directories can be filtered.
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The order of the filter specifications is decisive for inclusion or exclusion (for example *

B* and *. BAK) in the case of superimposed filter specifications. You determine the mode
by clicking on the symbol in the Mode column.

»J is to be processed
\'?) is to be skipped in the source, is deleted in the target

‘| isto beignored in source and target

You can use the standard elements on the right-hand side to add, delete, and change the
order of entries.

generates a list of the usual exclusions.

4.4 Source and destination

The following can be used as source and target

e drives
e network connections

e FTP / FTPS and

e WebDAV
Eratebngen
Oplicren Fied - Verhindungen
Ein+/Ausschiisse =
g FTF
£ Cuele T | FITS
S el Servemame:  dub de

Y ieerdung —
: ng Hlame B 105523 -dub

(] E-Mai e

Passwor

Noch ma

In addition, various measures can be activated:

o Encryption of the content of files

¢ Encryption of file names and/or directory names

e compression

Ermtnlungan
| Oplionen Fied - Kpdierung
B/ Aumichiuiss Varachi ”
il |E"‘|['! VierscHusssln Fihat Clabenriamer Vierzsichnesnamen
p—y Fa u
£ Vertancung s
e Moch mal

Enmprimienung

Packen
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REMARKS

Encryption / compression in the destination is cancelled by reversing to source with de-
cryption / decompression. Set up your own set of tasks for the best ones.

Gl - Kodienung

Entschilsselung

Entschimseln inhal Datenamen
Passwort

Verpsichnisriamen
Moch ma

Dieloompamisnng

Dk pmprimisnen

4.5 E-mail notifications

To monitor automated processes, you can have an e-mail sent to you at the beginning
and end with the result.

Einstellungen
e
] :.I‘IK.I'IEI E-Mai senden :_l th;rlr i"’ Erde
3 En-/Ausschilnss ~ —
] CGuele Empfanger dubidub de

7 Dol

Mbsender:  dub@diub de
E-Masi

Gorver:  dubde
Kortoname- Gehwsim

Passwor

Port 25 SMTF: 25

4.6 Compare files

To check all files of a pair, select Compare Pair in the Edit menu. The result can also be
viewed later in a protocol (see (8) Reports (Seite 14) ).

e Generation backups automatically check the last generation.

e The comparison takes the current inclusions and exclusions into account.

e The files in source and target are actually read and compared.

e The percentage display is based on the total number of bytes to be read in source
and target!

o Files that were in use and could only be copied by means of shadow copy (Volume
Shadow Copy) naturally lead to an error in the comparison.

REMARKS

This function is currently limited to drives as source and destination (hard disks, USB
sticks, network shares, etc.).
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5 Reparse-Points

| do not know any common German terms for the English terms. Therefore, a more de-
tailed explanation is given below. For me, these terms are even more relevant:

e Linked directory
e Integrated drive

e Symbolic reference

RENEWAL POINT / CROSS-REFERENCE POINT

As of version 8.1: the program distinguishes ver' link' te directories by type. Please adjust
your settings in the options!

Reparse' means something like' reanalysis/interpretation'. A' repair point' is in principle
always a reference across one or more file systems to another point in a directory tree.

e As of version 8.1: the program distinguishes ver' link' te directories by type. Please
adjust your settings in the options: Junction, hard-linked directory! A (sub-)directory
is additionally displayed at a different position in the directory tree. Path specifica-
tions are absolute.

e Built-in drive (Mount Point)
a 'volume', which normally has a drive letter such as L:, is included as a directory in
a directory tree of another drive (volume). This is also possible with' Virtual Hard
Disks'.

e Symbolic reference (symbolic link)
a reference to a directory, and this directory is displayed elsewhere in the tree ins-
tead of the file. The reference may contain a relative path specification. Also works
with network directories, unlike junctions.

This takes place at the file system level. In principle, the names of the links can be diffe-
rent from those of the targets. Of course, this is also available for individual files.

For  example,  your' Documents' directory is  such a link  to:
'C:\Users\[Benutzername]\Documents'. Desktop shortcuts are usually' symbol links' to
files or directories.

10
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6 FTP / WebDAV

Here are some tips for using FTP and WebDAV.

6.1 FTP

FTP stands for File Transfer Protocol and is specially designed to transfer binary files.
Stability.

¢ Although decades old, FTP should always be preferred to WebDAV access if possible.

e FTP servers are not the fastest in terms of response times.
Many individual accesses, such as reading the directory structure or transferring
many small files, are quite sluggish.

6.2 WebDAV

AND THE SERVER DOES NOT RESPOND....

WebDAV is not a good solution, because it is based on HTTP (Hypertext Transport Proto-
col) and inherits all the bad properties from it. Who has already experienced how web
pages only hesitantly and incompletely build up and at the end of the browser happily
simply gives up has a quite precise idea of what WebDAV does not accomplish.

This means

¢ no control over the data flow: whether the server still accepts the data at all during
the upload or discards it after only 2 seconds, one only finds out at the end.

o fussy with file sizes: the number of bytes to be transferred must be indicated exactly
at the very beginning. This means that parallel processing (encryption, compressi-
on, etc.) is simply not possible.

After all: thanks to the use of several different techniques, there is finally a progress
indicator when uploading, but inevitably a double one.

PECULIARITIES OF USE

Therefore, the following restrictions apply when uploading files.

e Double machining
Each file has to be edited twice, so the progress bar will go through it twice.
Step 1: copy to a buffer, compress, encrypt, etc.
Step 2: transfer the contents of the buffer.

e Time limits
Since there is no flow control, interruptions can only be detected via the detour of
time limits (timeout).
Problem 1: the speed of WebDAV often varies a lot.
Problem 2: the transmission of buffered data cannot be recorded.

11
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KAPITEL 6. FTP / WEBDAV 12

e Second try
AllWebDAV functions try their luck at least a second time after an error. In particular,
reading the directories even - with the time limit becoming ever longer - up to four
times.

e Big files?
The greater the amount of data to be transferred, the greater the probability of
termination. At a speed of 3 MBit/s, approx. 330 kB/s, there are regular problems
with 30 MB or more and you definitely reach the limit of usefulness with 100 MB
or more.
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7 Process flow

7.1 Manuell

s= ] Manual start of the synchronization.
= | Interrupts the process with a small delay in which the buffers are emptied.
The tasks are continued with .

we leads to the termination of all tasks without request.

7.2 Automation

FogMirror supports very complex tasks. In order to be able to integrate future extensi-
ons seamlessly, only two command line parameters are offered. This allows a previously
saved configuration file to be called up and processed automatically.

With the menu item Create icon, a corresponding link is created on the desktop.

o Task file
You can use a task file directly as a parameter, for example:
"0O:\Users\diub\Documents\diub\FogMirror\Teile auf Seafile.fmc6"

e Automatic startup
The -go parameter ensures automatic execution.

7.3 Attitudes

In the Menu->Settings—>Exit, you can define how FogMirror should behave at the end of
all tasks.

FogMirmor schlieflen

Froagbirmor schibefen

Solte ches nicht enwinscht sein, wahlen Se
Mobrechin

o Ok 3 Abbrechen

Tip
These settings

e are saved in the task file when saving, and

e can be changed during processing.

13
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8 Reports

The protocols can be viewed quickly via the Menu->File->Logs. Warnings and errors are
easy to detect. The number of days after which the logs are automatically deleted can
be set in the options (Menu—->Options->Options—>Logs).

e T Fragram Pl 86 Exdra’

On the left-hand side of the screen, the individual history is displayed with date, time
and result.

The right-hand side displays the details of the selected run.

14
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9 Important information

9.1 Encoding of file and directory names!

Starting with version 8.2: For compatibility reasons, the (optional) encoding of file and
directory names had to be changed dramatically! It is in no way compatible with the
previous version!

e Re-copying: the program will automatically (must) copy all files and directories.

e For security reasons, keep the version you have used so far.

9.2 Copy protection

As a rule, diub's programs are protected against unauthorized distribution by copy pro-
tection.

The circumvention and also the attempt to circumvent this copy protection will be pro-
secuted.

Two different variants are used:

9.2.1 Copy protection type I

Type: Permanent license for computers without regular Internet access.

TRAITS

Offline copy protection.

Activation is carried out once via the Internet.

No further access to the Internet is then necessary.

A porting of the license to another PCis generally not planned. Exceptions are hard-
ware changes, etc.

For porting to another PC it is necessary to contact diub.

9.2.2 Copy protection type II

Type: Licence for computers with regular Internet access.

TRAITS

Online copy protection.

Activation is carried out once for each PC via the Internet.

Further access to the Internet is required; activation is automatically extended.

It is easy to port the license to another PC.

For porting to another PC, it is usually not necessary to contact diub.

15
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